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SOFTWARE LICENSE AGREEMENT
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS.  YOUR INSTALLATION OF THE PROGRAM INDICATES YOUR
ACCEPTANCE OF THESE LICENSE TERMS. PLEASE READ THIS AGREEMENT CAREFULLY BEFORE INSTALLING THE
PROGRAM. SOLUSTAN, INC. WILL ONLY LICENSE THE PROGRAM TO YOU IF YOU FIRST ACCEPT THE TERMS OF THIS
AGREEMENT BY INSTALLING THE PROGRAM. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE
THE PROGRAM; EITHER RETURN OR DESTROY YOUR COPY.

These license terms apply to Your installation and use of the program, which program includes copyrighted materials and programs (collectively
referred to as "Program").  This license is granted to You by Solustan, Inc. You may not use the Program contained in this Package to upgrade
any existing Programs that You may have.  The Programs contained in this package are intended only for New Users of LinkMotion and/or
MaxMotion and not for any other use.

1.   License.  This Program is licensed and not sold.  Title to the Program does not pass to You. Solustan owns copyrights in the Program.  You
obtain no rights other than those granted You under this Program License Agreement.  The term "Program" means the original (including any
revisions, enhancements, updates, or the like) and all whole or partial copies of it, including modified copies or portions merged into other
programs.  You are responsible for the use of, and results obtained from the Program.  This Program may be used only on one machine at any
one time.  You may not reverse assemble or reverse compile the Program, except as specifically provided by law, without the possibility of a
contractual waiver.  You may not sublicense, rent, lease, or assign the Program.

2.   Disclaimer of Warranty and Limitation of Liability.  THE PROGRAM AND ANY OTHER PRODUCT WHICH WE PROVIDE TO YOU
AS PART OF OUR SERVICE ARE PROVIDED "AS IS."  EXCEPT AS SPECIFICALLY SET FORTH HEREIN, NEITHER WE NOR OUR
LICENSORS MAKE ANY WARRANTIES, REPRESENTATIONS OR CONDITIONS OF MERCHANTABILITY, QUALITY, AND
FITNESS FOR A PARTICULAR PURPOSE RELATING TO OUR PROGRAM, SERVICES, AND/OR RELATED PRODUCTS THAT WE
OR OUR LICENSORS PROVIDE.

3.   IN NO EVENT SHALL SOLUSTAN BE LIABLE FOR ANY DAMAGES RESULTING FROM THE USE OR MISUSE OF THE
SOFTWARE OR THE ACCOMPANYING MANUAL INCLUDING BUT NOT LIMITED TO DAMAGES FOR INJURY TO ANY PERSON
OR PROPERTY. THE PROGRAM IS DESIGNED TO WORK WITH MACHINES AND AS SUCH, ANY PART OF THE SYSTEM MAY
MISBEHAVE. IT IS IMPORTANT TO TAKE ALL THE NECESSARY PRECAUTIONS IN OREDR TO AVOID EQUIPMENT DAMAGE
AND/OR INJURY.

4.   WE DISCLAIM ANY WARRANTY OF TITLE OR OTHER WARRANTIES FOR ANY THIRD PARTY'S OFFERING(S) OR
PRODUCT(S).  ALL SUCH WARRANTIES AND REPRESENTATIONS ARE HEREBY EXCLUDED.  WITHOUT LIMITATION, NO
WARRANTY IS GIVEN THAT THE  PROGRAM OR PRODUCTS ARE ERROR-FREE.

WE, INCLUDING OUR LICENSORS, DISCLAIM ANY LIABILITY OR RESPONSIBILITY ARISING FROM ANY CLAIM THAT YOUR
ACCESS OR USE OF THE PROGRAM, SERVICE, AND/OR RELATED PRODUCTS WE PROVIDE INFRINGE ANY THIRD PARTY'S
INTELLECTUAL PROPERTY RIGHTS.

IN NO EVENT ARE WE OR OUR LICENSORS ARE LIABLE FOR:  A) DIRECT, SPECIAL, INDIRECT, CONSEQUENTIAL OR
INCIDENTAL DAMAGES EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY THEREOF INCLUDING, BUT NOT LIMITED
TO, LOST PROFITS, LOST BUSINESS REVENUE, OR FAILURE TO REALIZE EXPECTED SAVINGS; OR,  B) ANY CLAIMS
AGAINST YOU BY ANY OTHER PARTY.  This Section applies to all claims by You irrespective of the cause of action underlying Your
claim, including, but not limited to:  a) breach of contract, even if in the nature of a breach of condition or a fundamental term or a fundamental
breach, or b) tort including but not limited to negligence or misrepresentation.

In no event are We or Our dealers liable for any damages arising from Your failure to perform Your responsibility in connection with this
Program License Agreement, or arising from any cause beyond Our control, including but not limited to delay in the performance of Our
obligations or misuse of Your User IDs. All limitations and disclaimers stated in this Section also apply to Our Product Licensors as intended
beneficiaries of this Program License Agreement.  Any rights or limits stated herein are the maximum for which we are collectively responsible.

5. Termination.  This license is effective until terminated. This license will terminate immediately without notice from Solustan, Inc. if fail to
comply with any of its provisions. Upon termination you must destroy the Software and all copies thereof, and you may terminate this license
anytime by doing so.

6.   General.   You are responsible for payment of any taxes, including Your personal property taxes, resulting from this Program License
Agreement or Your use of the Program.  You agree to comply with all export laws and regulations.  Neither party may bring an action under
this Program License Agreement more than ONE years after the cause of actions arose.  This Program License Agreement and all Your rights
and obligations are governed by the laws of the State of Massachusetts.

7.   LinkMotion and MaxMotion softwares are protected with an ID (dongle) key. If the ID key fails for some reason, you could return it for
replacement. As long as Solustan can identify the key to be the one issued by us, we will replace it for a fee. On the other hand, if you lose the
key, you will be required to buy another license at a full price of the software. It is very important to safeguard the ID key.

Solustan, Inc. 165 Chestnut St., #200, Needham, MA 02492  Tel:781-449-7666 Fax:781-449-7759 email: support@solustan.com
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LinkMotion Detail Installation Instructions

Make sure that your computer has at least the following:

Windows XP operating system with Service Pak 2 or 3 and Microsoft .NET 2.0 Framework installed
Processor speed of at least 800 MHz
512 MB RAM preferred, contact us for laser raster work under virtual controller
100 MB of Hard drive free space
CD-ROM drive
Screen resolution of at least 800 x 600

2 USB 2.0 ports for LinkMotion USB product - Do not use any other USB 1.1 connection devices.

2 USB Ports for all board (Controller card) level products, Install the board (Controller Card)
and the related software per manufacturer’s instructions before installing Linkmotion.

1 parallel port and one USB port for all LinkMotion Virtual controller products.
Use Keyboard and mouse with PS2 connection only for all LinkMotion Virtual controller
products working with Parallel Port.

Note that you must have administrative privileges on the computer in order to install LinkMotion.

Now insert the LinkMotion installation CD into your CD-ROM drive. If the Auto-run feature is
enabled, Windows will start the LinkMotion installation automatically. If not, browse the CD drive in
Windows explorer and double-click on the "Launcher.EXE". You can also click separately on Sentinal
Protection Installer 7.4.0 and it will install I.D. key driver first. Next you can click on the Setup.exe and
it will install LinkMotion driver.

Keep the ID key handy but do not plug it in yet. You will be asked if you want to install the ID key
driver; answer "yes" (Demo users do not need to install ID key driver) if you have not already
installed the ID key driver and follow the on-screen instructions. Insert the key after full installation is
complete. Once the ID key driver has been installed, the LinkMotion installation will start.
The software is protected by the ID key. If the ID key fails for some reason, you could return it for
replacement. As long as Solustan can identify the key to be the one issued by us, we will replace it
for a fee. On the other hand, if you lose the key, you will be required to buy another license at a
full price of the software. It is important to safeguard the ID key.

Most of the installation process is self-explanatory. You can stop the installation at any time by clicking
"Cancel".

3



When you get to the License Agreement dialog (see below), you must click "I Agree"; otherwise you
will not be allowed to continue with the installation.
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After you have agreed to the License Agreement, you will be asked to specify the installation folder. In
most cases you can leave this at the default value. You will also be asked to specify who will be able to
run LinkMotion on this computer. In most cases you should specify "Everyone".
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Later during the installation you will be asked to Choose your application and Choose your machine for installation.
These choices will determine how LinkMotion will behave and what hardware it will be connected to. Note that some
machine names appear under both Virtual Controller applications and HPGL applications, so make sure that you select the
correct application before you select the machine. If you have any questions about which application and/or machine you
should select, check your LinkMotion installation CD, which will be marked with this information.

Choose your Application Choose your Machine

❑ Virtual Controller for Engraving ________________________
❑ HPGL Controller for Engraving ________________________
❑ HPGL Controller for Vinyl Cutting ________________________
❑ Virtual Controller for Marking ________________________
❘❑          Laser Machines for V/C and Boards ________________________
❑ Virtual Controller for CAM ________________________
■        Motion Control Boards _________Galil___________
❑ MaxHPGL/MaxUnica ________________________
❑ Virtual Controllers for FoamCutting ________________________
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During installation, if a dialog pops up warning you that you are installing an untested driver, click on
"continue anyway". This warning will be removed in a future release.

Click on "Close" when the installation is complete.

Setting up the Default Printer:

In most cases you will want the LinkMotion printer to be your default printer. Go to the Start button and
open the "Control Panel>Printers and Faxes" menu and find the LinkMotion printer (which has your
machine name or Controller Board name or LinkMotionUSB for USB product).
Check with us if your machine is not listed in Choose your machine.

Following are some examples:

Printer Names LinkMotion Application
Scanlab RTC4 Laser Macines for VC and Boards
Scanlab RTC3 Laser Macines for VC and Boards
Leetro MPC6515 Laser Macines for VC and Boards
LinkMotionUSB Motion Control Boards
Galil Motion Control Boards

7



Universal Laser LinkMotion for VC and Boards
Wizzard Virtual Controller for Engraving
Newing Hall Virtual Controller for Engraving
New Hermes 1219 Virtual Controller for Engraving
EGX 20 HPGL Controller for Engraving
EGX 400 HPGL Controller for Engraving

Right click on this printer and select "Set as Default Printer".

Post-installation setup and configuration:

In all cases you will have to configure LinkMotion before you can use it. Open the LinkMotion Control
Pad by double-clicking on the LinkMotion icon   in the system tray in the lower right of your screen.
Note that you must click "OK" or "Apply" for any changes to take effect. ControlPad, Material
Properties, Machine Properties, Motor Parameter, Origin setup, General Options, Laser Controls, Galvo
and Controlled Laser are the different tabs available for proper settings of your machine. These tabs are
designed for specific applications and you will see only related to your application. Please understand
the functions of these and setup properly before you start using your machine.
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LinkMotion for Laser machine boards like Scanlab RTC4, RTC3,
Scanalone4, Leetro MPC6515, IPG Laser, etc.):

Install the board (laser Controller cards) and the related software per manufacturer’s
instructions. Boards that needs to be installed inside your computer should be installed first.  USB
based controller cards may be connected externally.

Make sure you have set up your machine driver as default printer driver in your XP system. Click on
the start button and select Printers and Faxes. Right click on the driver name Leetro MPC6515 or
Scanlab RTC4….. Select this as ‘Set as default printer’.

Boards that have USB connections can be connected with the USB cable to your computer and it
will recognize the new hardware.

There are many possible reasons for the USB communication malfunction:

1. Windows operating system temporarily suspends USB devices if they are not used and dormant for a
period of time.

2. Windows screen savers or power saver mode creates interruptions in USB communication from time
to time.

3. If for some reason, USB interface cable between the controller and the PC were removed or came
loose, communication will be interrupted. Upon connecting back, Windows will recognize the device.
However, LinkMotion driver needs to be launched again to establish the communication with the
controller. Right click on the LinkMotion icon in the system tray and select EXIT. Go to the Start button
in Windows and re-launch LinkMotion.
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Uninstalling LinkMotion:

Please make sure of the following before you uninstall:

Your specific machine related settings are saved as LinkMotion.ini file. This file can be saved from
General Options Menu and simply click on the Save button and give whatever name you prefer. You
can also navigate where in your hard drive you want to save it. Different users can save under different
names. Similarly you can Load that file back after another installation of LinkMotion by going to the
General Options menu and clicking on the Load button. Navigate to the file from your computer where
you saved it earlier. Restore Default button allows you to load default installed INI file that is supplied
with LinkMotion. It is very important to exit Link applet and Re-launch the applet when you
change and select another INI file for it to be effective.

Uninstall LinkMotion Procedure:

Make sure the LinkMotion applet is closed. Open the Start menu and select the Control Panel.
Double-click on Add or Remove Programs. Look for LinkMotion entry in the list and click on that.
Select "Remove" and answer "Yes" when it asks you if you really want to remove LinkMotion.

If you want to delete your existing INI file following is the procedure:
In the hard drive Find folder name Document and Settings> Folder with users (your own name)
name> Folder name Application Data> Folder name Solustan> Folder name LinkMotion>
LinkMotion.INI. Delete this file.

If you are uninstalling before installing a new version of LinkMotion, you do not need to uninstall the
Sentinel (I.D. key) Driver.  Sentinel Driver can be removed the same way as LinkMotion but simply
select Sentinel Driver.
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LinkMotion and Galil Board:
The LinkMotion driver comes with a small application that resides in the System Tray. The System Tray
is the lower right bar of the Windows screen. Double click on the LinkMotion icon to bring up the
application. Based on the selection, the Control Pad will show up in English, Spanish, or symbols.
Control Pad can be designed easily into any of the languages of the world.

Your computer should have Windows XP operating system with Service Pak 2 (SP 2) installed,
one parallel port (on original mother board) and one USB 2.0 connection. Also you should install
Microsoft .NET Framework Version 2.0. This is available form Microsoft’s web site for you to
download freely:
Microsoft.com>Downloads & Trials>Download Center>.NET Framework Version 2.0
Do not use Keyboard or mouse connected with USB connection. Use PS2 connections.

First follow proper installation and set up for hardware and software of the Galil boards.
Now install LinkMotion following the instruction that you received with your LinkMotion CD.
First part of the installation is for LinkMotion I.D. Key driver and the second part will be the
LinkMotion driver application. Make sure to select Motion Control Board under application
and Galil under machine name during the last part of the LinkMotion installation.

Warning for Control Pad (All functions may not be supported for board
level products):
Please avoid using the mouse after you have sent the job for the output. Once the
job is done, your mouse should be available for use. Use the ‘Zero’ or the ‘Space
Bar’ key on your keypad to Pause. You will see a message box asking you if you
want to Continue or Quit the job. (Some times this message box is in the back of
your Control pad and you can bring it to the front simply by clicking on the system
tray’s active LinkMotion application.) At this point you can go to LinkMotion and
change the speed or depth in the materials menu, click apply and then click Yes to
Continue the job or No to stop the job completely. Keep in mind that if it is in the
'Move Mode' between the shapes or letters, it may not pause. When jogging the
machine do not press three keys together, it may cause undesirable results. Some
times pressing two keys together for both X and Y movements can cause machine to
continue moving in one direction even if you are no longer pressing the key.
Pressing the same key again or the opposite direction key should stop this
unnecessary movements.
Do not use the arrow keys elsewhere on the keyboard in place of the Control Pad
keys.
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Control Pad (All functions may not be supported for all board level
products):

The Control Pad is operated using the numeric keypad, the right side of the extended PC keyboard.
Click on the Apply button after any changes you make on any of the Tabs (Menus). Changes are
effective only when you click on these buttons.

Limit switches show up at the top of the Control Pad for each axis. If switches are present and properly
configured, it will show green color when not tripped. Move the table in any one of the axis until the
switch is tripped, the green color will change to red. Settings for the switches are in the Origin Setup
menu.

Reset Counter – Basic function of this is to Reset Counter to 0 value for each X, Y and Z axis
positions. If you move the tool any where on the table, the X, Y and Z the counter will display the actual
position of the tool. If you then click on the Reset Counter it will make all the display values to 0, 0, 0.
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Machines without the Home switches or selecting a new staring position on any machines are some of
the useful functions of Reset Counter button.

Move To 0,0 – Clicking on this button will make your machine move your X and Y position to 0, 0
location if the counters show values other than 0, 0.  This is a useful function for resetting back to the
start position for the machines without the Home switches.

Clicking on the Solustan logo will take you to Solustan web site, if the computer is online and connected
to Internet.

All the blue colored keys are designed to move X, Y, and Z axis with respective direction. Following are
the keys for each axis X left (4), X Right (6), Y Up (8), Y Down (2), Z Up (-), Z Down (+) and Move
Fast (5).

Move Fast Key (5) is pressed along with X or Y key movement to make it move faster. For faster
movement you also need to have faster speed in the Move section of the materials menu. Move value is
responsible for two functions. One function is fast jog speed and second function is tool up speed when
it lifts up between the shape while doing a job.

Z Ref key (*) is clicked when the tool is just touching the top of the material. LinkMotion will
remember the reference surface for the job. It will use the Z reference to calculate the moves in the Z
axis for the depth and lift as it processes the job. If your machine has the home switch for Z axis and if
it is activated in LinkMotion, Z Reference value is automatically calculated. If your machine does
not have the home switch then you can declare the Z Reference value in the Origin setup in the Z
offset for Start Position and it will go up by that distance with the Z Reference Key.

If your Z stroke is 3 inches or more and you do not care to travel the full stroke while seeking the
home switch during homing operation, you could declare Z home switch not enabled and declare
your own Z-up stroke in the Z-offset in start position of Origin setup menu.

HOME key (7) will move the machine to its Home position, if the machine is equipped with home
switches. Machines may have home switches in X and Y axis or all the three axis.

I/O Keys (1), (3), (. or Del) and (9) are available for I/O 1, I/O 2, I/O 3 and I/O4 controls. These could
be used to control Z axis movement in case Z axis is not motorized but it is solenoid and is controlled by
air valve, for example. Can also be used for lubrication of tools, vacuum control, laser control, red
diode, air, water etc. Each click of the keys can toggle the I/O position. User can set to make the action
momentary or toggle by way of settings in the LinkMotion .INI file.

Spindle Control for CNC type application or Air Control for Laser type application - Key (9) I/O 4
is used to control spindle motor or air in case of laser application. Each click of the keys will toggle the
I/O position.

The big 0 (zero) or Space bar key is available to stop processing of the job anytime.
When job is being processed it is very important to remember not to touch the
mouse and the rest of the keyboard.
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Num Lock and \ keys are available only when machine is in motion.
These keys can decrease or increase the speed of the X, Y movements of the machine. Do not keep this
key pressed for long time. Simply press and release gently each click of the key will decrease or
increase the speed according to the settings in the LinkMotion.INI file. OnTheFlySpeedChange=4 is a
default value in the INI file. This number works in percentage value of the original speed specified in
the Job feed rate of the Materials menu. When the machine is in motion user can decrease the speed
by pressing Num Lock Key. Similarly user can increase the speed by pressing the / Key. Once the
job is done the speed again goes back to what is declared in the Job Feedrate of the Material Properties.

Control Pad in Spanish language:
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Go into General Options menu. Look at Control Pad Labels. Arrow to the right will show you the
choices you have. Here select the Spanish Control pad and click on Apply button. Now you will see the
Spanish control pad.

Control Pad with Symbols:

Go into General Options menu. Look at Control Pad Labels. Arrow to the right will show you the
choices you have. Here select the Symbol Control pad and click on Apply button. Now you will see the
Symbol control pad.
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Materials Properties:

Pull down the Material Properties menu to observe a selection of various materials. Pre-select the
values of speed and tool positions for each of the materials. The default values are simply that.
LinkMotion can be employed to work with many different types of machines. Hence, there is no single
value appropriate for all different machines. User’s experience will dictate the values for his/her
machines.

The values can be inches per second or millimeters per second or centimeters per second. General
Options menu allows you to make your selection for this measure of units.
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Jobs can be designed in color and job feed rate speeds can be defined as percentage of declared values
for each of the color. One of the applications of this feature is to design the same job in different colors
on different layers and sequence the layers appropriately.

Following are the color/pen values for the LinkMotion printer driver.  RGB values are given in percent.

      Pen number Color R G B
      --------------- -------- --- --- ---
          1 Black 0 0 0
          2 Red 255 0 0
          3 Green 0 255 0
          4 Blue 0 0 255
          5 Cyan 0 255 255
          6 Magenta 255 0 255
          7 Yellow 255 255 0
          8 Orange 255 128 0
          9 Brown 128 0 0
         10 Purple 128 0 128

If you did not create a color palette with the above RGB values, our understanding of the way GDI
handles this is that GDI will convert the object's color to an RGB value using whatever color correction
model is in effect, then will do a least-squares fit to the 10-color palette (whichever of the 10 colors is
closest to the color of the object on a least-squares bases will be the color that is sent to the printer
driver).

Job feed rate is the speed when the tool is engaged into material and working. Bringing your arrow on
the number that shows Job Feedrate (100%) for each pen and Double clicking on the number should
open a box that will allow you to change this number. If your job federate in tool speed is 2in/sec and
you make the red pen to give output at 50% then job should run at 1in/sec.

Jog speed is when the user is jogging the machine with the help of Control Pad.

Move speed has two functions, it is the speed when the tool is retracted and the machine is moving to
the next shape after finishing the previous one and it is also used for fast jogging (holding down fast
key while keeping the directional key pressed).

User can set up separate speeds for Z feed up and Z feed down.

Depth is the value declared for tool to travel in the material. Once the top of the material surface is
determined, depth value controls the movement of the tool in the vertical axis.

Maximum depth per pass (This may not be available for all board level products) is the value
declared if you wish to do your job in multiple passes. For example if you have selected 0.15 in to be
your Depth value and you want to do your job in three passes you can declare 0.05 in value for
Maximum depth per pass and your job will be done in three passes. When you send the job you should
see the dialog box for Pause Between passes. User can select to pause between the passes or continue
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without the pause in the dialog box when doing the job with multiple passes as shown on the screen
below. Your tool will always return to 0, 0 for X, Y position (Regardless of weather you have checked
or unchecked in the origin setup for Return to 0,0 after job) and then do the next path. If you declare 0
value in multiple pass it will always do the job in one pass.

Lift is the value for tool to lift between the shapes to do the job. If you have several inches of travel
available for Z axis then it saves time to plug in the lift value where it does not travel all the way up for
Z axis between the shapes and instead it travels only by the Lift value and saves time.

Dwell is the amount of time in seconds and fraction of seconds the tool will stay at the same position in
the material before making X, Y move and after finishing the shape to cut the material.

The three levels of power determination is useful in case an electrical solenoid is required to control
downward force, for example. A control panel for laser machine would have eight levels of selections
for power and speed of operation.
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Machine Properties:

Board level products are also different for I/O support. Please check before using these functions.

If Enable I/O control 1 is checked, it will turn the I/O ON while cutting/engraving a shape during a job
and turn itself OFF at the end of completing the shape. The I/O will stay OFF during the traverse/Move
motion to the beginning of the next shape. You can test the operation of the I/O by either clicking on the
Key 1 button with a mouse or depressing the key on the Control Pad.
 
If Enable I/O control 2 is checked, it will turn the I/O ON while cutting/engraving a shape during a job
and turn itself OFF at the end of completing the shape. The I/O will stay OFF during the traverse/Move
motion to the beginning of the next shape. You can test the operation of the I/O by either clicking on the
Key 3 button with a mouse or depressing the key on the Control Pad.
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Z axis can be selected as solenoid or air controlled. It may be attached to I/O 1 or I/O 2.

If Enable I/O control 3 is checked, it will turn on and off with the job execution. You can check by
clicking Key Del (.) on the Control Pad.

If Enable I/O control 4 (Spindle) is checked, it will turn on and off with the job execution. You can
check by clicking Key 9 on the Control Pad. The value of delay can be entered in seconds and fraction
of seconds in the Spindle Delay area. This delay value will allow the spindle motor to reach its speed
before the tool plunges into the material.

Safety, Limit, and Emergency controls

Pin 15 on the parallel port is available for connecting safety, limit, and emergency switches. We will
expect Logic 0 on pin 15 for the machine to operate normally. When we see logic 1 on pin 15, the
job will be aborted or will not start. Once job is aborted, it cannot be recovered. It has to be restarted.
We feel Logic 1 is failsafe and requires active response from the safety apparatus for it to work properly.

Directions for X, Y and Z can be set properly here by checking or un-checking the direction button.
If the axis movements are opposite to the intended directions, the direction or directions can be reversed
without changing the wiring.

The maximum travel distances of the machine in X, Y and Z axis is shown here. The maximum
travel numbers (in other words the size of the table) should match the Design applications you are using
like Corel Draw or Auto Cad for the job to appear in the expected place on the machine.

Linear travel per revolution (lead screw pitch) is shown here and you can change this if necessary.
There are unknowns in a system from time to time. These are the pitch of the screw (2 turns per inch, 5
turns per inch, etc.), full step angle of a step motor (200 full steps for 360 degree turn, etc.), and micro
stepping of the driver. If you know any two of the three, the third one can be determined using nudging
feature of the Control Pad. Typically, most of the Control Pad is activated using physical keys of the
keyboard and using them with fingers. The nudge feature is activated using a single click of the mouse
on the appropriate key on the screen. Nudge a distance by declaring the distance in the General Options.
Next, measure the actual distance moved by the machine. Make the necessary correction of the value for
the unknown parameter until you get the desired distance by nudging.

Cylindrical axis choices will be offered if the machine is equipped with it. It is very important to quit
and Re-launch LinkMotion applet after you make this selection. Maximum Travel size of the table
in X or Y will change when you Enable Cylindrical Axis Support. You do not need to enter this
new size in Maximum Travel area in LinkMotion applet. However, it is very important to
remember the dimensions and create that Table size in your design applications like Corel or Cad.
Selecting X or Y whichever is the cylindrical axis for your machine. Motor Gear Ratio and Job Piece
Diameter is entered for your job in the bottom section.
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Motor Parameters:

Servo motors might have different settings in board level products. Please check before using it
from here.

Above values are determined by the motor manufacturer. Enter Full steps per revolution values for
each axis depending upon the motor and the lead screw size specifications.

Declare Toolhead Maximum Acceleration values for the motors in each of the axis in in/seec^2. You
may need to adjust this numbers to get proper acceleration constants for smooth motion. Check with
your machine manufacturer for the correct numbers required for the machine. In absence of that, you
should start with a number between 25 and 100 as a safe starting point.

Set the Microsteps per every full Step for your system for each of the axis. This is necessary only if
you are using step motors in your system. This number is derived from the Amplifier driver used for

21



your motors. In case of servo motors, you need to make sure that the multiplication of numbers in this
area as well as in the number of full steps per revolution of the motor in the Motor parameters match
your encoder number for the feedback. Generally, it would be a good idea to declare number 1 as the
number in microsteps per every full step and the encoder resolution number in the number of full steps
per revolution in the motor parameters location.

Maximum Motor RPM number should be selected by the specifications given by your motor
manufacturer.
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Origin Setup:

All functions may not be supported from board level products.

Return to 0, 0 after job (Go Home After Job) – If you have not checked this box then after finishing
the job it goes up for Z axis and stops at the position where it finished the last shape. It does not move
it’s X and Y position. It does not go to the start position. Checking this box makes your tool go back to
the starting position (parking position) for X, Y and Z axis. If your machine has the limit switches
and limit switches are enabled it will sense those switches and park the tool to its home position.

Start Position:
Bottom Center, Bottom Left, Bottom Right, Center, Top Center, Top Left and Top Right are the
choices.

If your Home Position and Start Positions are the same following are the selection necessary:
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Some are not available at this point.
Home Position Selection Start Position Selection
Bottom Left Bottom Left
Bottom Right Bottom Right
Top Left Top Left
Top Right Top Right

Job start position can be different than the Home position. Job start position may be,
- Where the jig is positioned (Home Position)
- Center of a machine in case of a vise type machine with offset values in X and Y where both

jaws move
- Top center of a machine with offset value in X only in case of a machine where only bottom

jaw moves

In above situations and others, it is necessary to select Start Position and declare offset values for X and
Y appropriately.

If you suspect that there is a problem with one or more limit switches and it is hindering your
production, check the Disable limit switch box at the top. This will allow the operation of the machine
while the limit switches are being investigated.
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Motion Control Board – Galil:

First follow proper installation and set up for hardware and software of the Galil boards. Make sure of
the parameters and other necessary settings that Galil recommends for the proper operation of the board.
Now follow installations and settings for How to use LinkMotion. Following is the information for using
the Galil board with LinkMotion.
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Settings required for Galil:

Disable limit switches. The limit switches are under Galil board control. All LinkMotion does is that it
issues Home command, when clicked Home on the Control Pad.
The software is tested for only Top Left starting position. That is the position that should be selected and
accordingly wired on the machine using Galil control board. By doing this, there will be no surprises for
the starting position of the job. Initially, dry run a few jobs just to become familiar with the workings of
the LinkMotion along with the Galil board.

Two things to remember:
1. Once you select Galil board on PCI slot or on the Ethernet connection, selecting an output port like
LPT1 or anything else is not relevant and not necessary. It is ignored by LinkMotion.
2. Galil boards may not be used for controlling laser machines. You may not see a way to handle
bitmaps in this option.

A note on Galil job structures and user-defined commands:

The Galil user interface allows the user to define the following command sequences which will be sent
to the board during a job or during jog operations:  "Start Job", "End Job", "Start Shape", "End Shape",
"Color Change", "Start Pause", "End Pause", "Abort Job", and "Motor Setup".
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Color Change commands, and handling of color changes, are not currently handled.

The Galil interface assumes that the Z axis handles the cutting tool. For situations where the tool is not
handled by a Z-axis motor, the user should make sure that the "Z axis is solenoid" box is checked on the
Machine Properties tab.

During a job, commands are sent to the Galil board in the following sequence:
- "Motor Setup" commands
- "Start Job" commands
- "CAS" command
- (command sequences for shapes, see below)
- "End Job" commands

For a shape, commands are sent to the Galil board in the following sequence:
- "LM XY" command
- "VS", "VA", and "VD" commands  (set "move" speed and acceleration)
- "LI" command(s)s to move to a shape's starting position
- "BGS" command
- "LE" command
- wait for motion complete
- "Start Shape" commands
- move Z axis down if not a solenoid
- Wait for dwell time
- "VS", "VA", and "VD" commands  (set "engrave" speed and acceleration)
- "LM XY" command
- "LI"/"BG" command pairs to follow the shape's path
- "LE" command
- "BGS" command
- wait for motion complete
- move Z axis up if not a solenoid
- Wait for dwell time
- "VS", "VA", and "VD" commands  (set "move" speed and acceleration)
- "End Shape" commands

For jogging, commands are sent to the Galil board in the following sequence:
- "Motor Setup" commands
- "AC", "DC", and "JG" commands for the appropriate axis
- "BG" command for the appropriate axis
- wait for key release
- "ST" command for the appropriate axis

During a job when a pause is requested, commands are sent to the Galil board in the following sequence:
- "VS ?" (query for current velocity)
- "VS 0" (set velocity to zero)
- move Z axis up (if necessary) if not a solenoid
- "Start Pause" commands
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- wait for user to allow job to continue
- move Z axis down (if necessary) if not a solenoid
- "End Pause" commands
- "VS" command to restore previous velocity

During a job when a job abort is requested, commands are sent to the Galil board in the following
sequence (note that a job abort is initiated the same way as a pause job):
- "VS ?" (query for current velocity)
- "VS 0" (set velocity to zero)
- move Z axis up (if necessary) if not a solenoid
- "Start Pause" commands
- wait for user to abort job
- "Abort job" commands

User can modify and write their commands.
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General Options:

There are just a few things in the General Options screen. Units of choice can be selected from inch,
mm, or cm.

The Nudge will allow the axis to move a fix distance when any axis is moved with a single mouse click
on the keys that move the X, Y and Z axis when Control Pad tab is open or selected.

Control Pad Labels: Arrow to the right will show you the choices you have. Here select the English,
or Spanish or Symbol and click on the Apply button. Now you should see the control pad you have
selected.

Enable Braille support is an optional feature and it is designed to drill dots. This is used for creating
Braille signs. Adot is the font we provide when Optional Braille support is purchased. Selecting this
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option makes your tool travel to the begin point of each shape and go down to create a mark or a hole
and go back up and go to the begin point of the next shape.

Hide OEM setting is for OEM customers only and it hides some of the control pad settings as
requested.

Save Settings:

Save:
Once the machine is properly configured and is working well, it is advisable to Save the settings on
the hard disk drive. This is saved as LinkMotion.INI file.
LinkMotion.INI file is located on your hard drive C:\ Document and Settings> Folder with
computer users name> Folder name Application Data> Folder name Solustan> Folder name
LinkMotion> LinkMotion.INI.
Click on the Save button and it will ask you to give a file name. Make sure to remember the file name,
and where you are saving it. You can navigate on your hard drive where you want to save. You can also
rename the file with what ever is easy for you to remember. Mostly our customers rename the file with
their machine name.

Load:
In case the LinkMotion needs to be loaded again from the CD supplied by Solustan, or you need to
load upgraded version the user will be able to reload all the settings with your .INI file without
wasting any time. For loading the settings back select Load button and navigate to the saved .INI file
and click on Apply and OK.  Now click on the right mouse button when you are on the LinkMotion
appellate and exit the program. Go to the start button and launch back LinkMotion. You should see all
your saved settings here now.

Restore Defaults:
Clicking on this button will load default LinkMotion.INI file that we supply with the LinkMotion
driver.

It is very important to exit Link applet and Re-launch the applet when you change
and select another INI file for it to be effective.

LinkMotion driver mode of operation:

General purpose mode – This is loaded by default. This mode is used when you use Corel, AutoCAD
type of design softwares and use LinkMotion to send files to your machine. Only MaxMotion users do
not need to use this mode.

Instructions for I.D. key Upgrade:

This is required only when you need to upgrade the features offered or upgrade to use with the
new version of LinkMotion or upgrade the number of executions for the I.D. Key.
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To upgrade your I.D. key you will receive a code as a text file from us.
Note pad or Word pad type of utility should open this code.
Simply highlight the code with a cursor. Right mouse click and select Copy.

Now launch LinkMotion Icon. Click on the General Options menu. Click on the button Update I.D.
Key. A dialog box will open. Right mouse click inside the Authorization Code box. Select Paste. Click
OK. Click on OK in General Options menu.
Now right mouse click on the LinkMotion icon and select Exit.
Go to the Start button. Select All Programs. Select Solustan folder and select LinkMotion application.
Now you will see a LinkMotion Icon on the bottom right again. You are all set to work with your
updated I.D. Key.
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Application Compatibility with LinkMotion:
Go to www.solustan.com/support and download instructions for the appropriate design application you might be using.
Some applications have their own limitations and mostly it is listed in the document. We are adding information as we test
with respective applications.

1. Corel Draw version 9, 10, 11, 12, 3X

2. Corel Paint Shop Pro (Raster Only)

3. Adobe Illustrator

4. FreeHand MX

5. EngraveLab / SignLab version 6.0 and higher

6. FlexiExpert

7. AutoCAD version 14 and higher

8. DolphinCAD specially designed version for LinkMotion

9. Rhino 4.0 Beta

10. Instant Engineer 14

11. IntelliCAD (AcceliCAD)

12. BarTender (Raster only)

13. Microsoft Word (Raster only)

14. PhotoShop (Raster only)

15. Gerber's ArtPath

16. MaxMotion
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Frequently Asked Questions

General Questions for LinkMotion:

1. When should I plug the ID key (software protection key) in the USB port at the time of
installation?

Start installing the software for LinkMotion or MaxMotion. Installation procedure will tell you to
insert the key or you wait till you have installed the software successfully before inserting the key in
one of the USB ports. This key is required in your computer all the time while you use LinkMotion or
MaxMotion software.

In case of installation of LinkMotion for USB you should plug in the ID key after it finishes
complete installation for LinkMotionUSB.

2. What options are available to me if I lose the ID key?

LinkMotion software is protected with an ID (dongle) key. If the ID key fails for some reason, you could
return it for replacement. As long as Solustan can identify the key to be the one issued by us, we will
replace it for a fee. On the other hand, if you lose the key, you will be required to buy another license at
a full price of the software. It is very important to safeguard the ID key.

3. Do I need to access LinkMotion driver software once loaded?

Generally, you simply deal with your job design software and your machine. We do provide an
accompanied settings application. This application can be invoked from its icon in the SysTray area.
This application will allow you to jog the machine in all axis, go home if the machine is equipped with
home switches, surfacing, pausing a job, setting up feed rates and other speed settings, cylindrical work
settings, laser related settings, port selection, and multitude of other settings based on the type of
machine you are having.

4. How do I know if my LinkMotion is installed properly?

When you launch LinkMotion applet does it show the title “LinkMotion for Your Machine Name –
Ver. 1.5.4” (version that you have). If this is not proper you may have installed the wrong
application or for the wrong machine. You need to uninstall and re-install LinkMotion again by
windows standard uninstall procedure.
In case of LinkMotion with USB Controller you should see the title LinkMotion for
LinkMotionUSB.

When you see the title “LinkMotion for Your Machine Name – Ver. 1.5.4” (Demo Mode).
LinkMotion is in Demo mode and your ID key (dongle) is not recognized. Either The Sentinel
Protection driver (ID Key driver) is not installed properly or ID key is not proper for the application
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you are using. User may need to reinstall the Sentinel driver or get in touch with us for the proper
license.

5. How do I access LinkMotion driver software for various settings?

This application can be invoked from its icon in the SysTray (Lower right corner) area. This application
will allow you to jog the machine in all axis, go home if the machine is equipped with home switches,
surfacing, pausing a job, setting up feed rates and other speed settings, cylindrical work settings, laser
related settings, port selection, and multitude of other settings based on the type of application and the
machine you are having.

6. How do I select and set up my machine?

The selection of the machine takes place during the installation of LinkMotion. Read Install and
Uninstall LinkMotion part of the manual available on your CD. Latest files are in the folder name
Manual-PDF. Please open appropriate file for the application you have purchased LinkMotion for and
follow the instruction.

7. I click on Z axis and I do not see any movement on Z axis. Why?

You may have solenoid controlled Z axis or motor control Z axis. In case of solenoid Z axis you can see
the control from the I/O 1 or I/O 2 depending on how it is connected. Some laser machines also may
require to select Z to be solenoid and that removes Zaxis related selections to work properly. In case of
motorizes Zaxis it should move up and down by – and + keys on the control pad. Also, it is possible that
you may have selected a wrong machine while installing LinkMotion. Laser applications are designed
where you need to select Z axis to be solenoid and that will gray out Z axis motor related controls.

8. My machine is connected. I can jog the machine using the ControlPad. However, the directions
are wrong. What do I do?

Launch LinkMotion from SysTray. Go to Machine Properties menu. Reverse the direction of the axis
that are wrong. Click Apply. Read the details in the HELP tab under the chapter How to use
LinkMotion. Some LinkMotion applications do not require control pad so you may not see it. Machine
properties may not be available for LinkMotion that works with some controller applications.

9. Can I change speeds of operation? How?

Launch LinkMotion from SysTray. Go to Material Properties. Set values for speeds of operation for
different materials. Click Apply. Read the details in the HELP tab under the chapter How to use
LinkMotion or LM&USB.PDF.

10. Can I preset values for speeds of operation for different materials? Where?

Launch LinkMotion from SysTray. Go to Material Properties. Set values for speeds of operation and
other settings for different materials. Read the details in the HELP tab under the chapter How to use
LinkMotion.
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11. How can I change starting positions of a job?

Check the Origins Setup tab in the LinkMotion settings. Note the Home Positions and Start Positions
and the offset values for each axis. Read the details in the HELP tab under the chapter How to use
LinkMotion. Laser related applications may have these selections under Laser controls.

12. How can I check and make sure my Home switches work properly?

You can check a few clever things easily before exercise Home switch command.

Set up your switch polarities in LinkMotion. Turn on the power to your controller and machine. You
should see green lights for X, Y and Z axis (If you have a motor and a home switch in the Z axis) on the
Control Pad of LinkMotion next to the X, Y and Z coordinate values. If you can get to the home
switches, actuate the switch and see that the appropriate light turns red. If not, you may have a wrong
connection, no connection, loose connection, broken switch, or wrong selection of the pin number or the
polarity in the Origin Setup. Some LinkMotion applications may not see this setup.

13. I am sending a job and the machine does not come alive to execute the job. What am I doing
wrong?

This situation may occur due to any of the following:
(A) Check the power of the machine.

(B) Check the print queue for any extraneous documents and remove them.

(C) Check the feed rates and other settings to make sure that they are all correct.

(D) Check the output port selection in the general option menu for all Virtual Controller applications.
Selection of the Parallel port address should be correct here. Most of the time it is LPT1, LPT2 etc.
Sometimes it has the custom address and selecting the proper custom address is important.

(E) You might have selected thick outline or filled object and engraving or routing applications do not
understand those commands. Only laser type of applications support raster work or line with thickness.
Other machines can only take vector lines.

(F) Printer driver installed for your machine may not have been selected as DEFAULT DRIVER.
Please check in Control Panel>Printers and Faxes>Your Machine Driver (this should be selected
as default driver).

(G) If Service Pak 2 was not installed on your Windows XP operating system you may see the
problem of LinkMotion not sending anything to the machine. You need to uninstall the LinkMotion
and Sentinel driver and then install the Service Pak 2 and re-install both the Sentinel driver as well
as LinkMotion.
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(H) Mode of operation needs to be checked properly in General Options menu. MaxMotion mode
only works with our older MaxMotion application. Customers using Corel or Cad type of design
application should only use General purpose mode.

(I) LinkMotion in Demo Mode (without the ID Key) allows user to send the output 40 times and
then it will not send file to the machine. User can only make it work by buying the proper license
from us after those 40 executions expire.
ID Keys (USB) also can be programmed for number of executions.
Example: Your ID Key may be programmed for 400 executions. This means user can output 400 files.
After this LinkMotion goes into a Demo mode. This means there is no output capacity available. We
can upgrade that ID key by sending you the code for either add number of executions or remove
the limitations for number of executions. This is easily done by email.
If you do not have proper application license then job does not go to the machine.

(J) LinkMotionUSB does not support Demo Mode at this point. I.D. key and the USB controller
board is required to test all the functions of USB product.

14. I am sending a job and the machine does unexpected things. What am I doing wrong?

You might have the wrong mode selected in the LinkMotion. In General Options menu there are three
modes of operation. General purpose mode, MaxMotion mode and Pass through mode. Corel or any Cad
type of design software users should have it in General purpose mode. MaxMotion VC users should
have it in the MaxMotion mode. MaxHPGL or MaxUnica users should have it in the Pass through mode.

15. I am having problem with surfacing and homing the tool on my machine. Why?

LinkMotion Virtual controller surfacing and homing works differently then LinkMotionUSB product.
Please understand form the proper documents how it works and then start using it for production.

16. How do I Pause a job?

Space Bar or Zero Key on your accounting key pad of your Key board will pause the job any time.
After a job is paused you get a message if you want to continue or quit. Make your selection. If you
select continue then it will finish the rest of the job. If you select not to continue it will ask you if you
wish to go back to 0, 0 position or you wish to stay at the position where you are. Make your selection
and work accordingly. Pause may not be available in LinkMotion if controller controls those functions.

17. I am using LinkMotion for engraving. When I engrave, the characters are perfect but the
spacing between the characters as well as the positioning of the characters is not proper. What am
I doing wrong?

Your Move speed might be too high. Check the Materials tab in LinkMotion. Job Feed rate and Move
speed should be checked.
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18. I am using LinkMotion for engraving. When I engrave, the characters are less than perfect
and the spacing between the characters as well as the positioning of the characters is not proper.
What am I doing wrong?

Your speed settings might be too high. These are Feed rates and Move speeds. Also, machine settings
might be a suspect. Check the Materials menu in LinkMotion.

Questions for settings and installation on your Computer:

1. How to see hidden folders in windows?

Go to the Start button. Select Control Panel. Select Tools Menu and select Folder option. Click on
the View menu. You should see a folder called Hidden files and folders. Here select the button for
Show hidden files and folders. Click on the Apply button. Now you will see all the folders.

2. How to check if I have installed Service Pak2 on my computer?

Go to the Start button. Select Control Panel. Select System. Now in General menu it should show if
Service Pak 2 is installed. Also you can install and uninstall by windows standard Add/Remove
program procedure. Make sure you install LinkMotion after you install windows operating system
related update first.

3. How to check if I have installed .NET Framework 2.0 on my computer?

Go to the Start button. Select Control Panel. Select Add/Remove programs. Here you should see if
you have installed the .NET Framework 2.0 of Microsoft. This is required to work with our new
version of Linkmotion.

4. How to see the file for my LinkMotion related settings?

This file is named LinkMotion.INI.
Go to your C:\  > Documents and Settings > Folder with computer User’s name (how ever you
have set up your computer) > Application Data > Solustan > LinkMotion > LinkMotion.INI.
This file has all your machine related settings. You can save this file under different name as well as
reload this file from where you might have saved this file.

5. How can I tell if my computer has USB 2.0 or 1.1? What is the difference?

USB 1.1 transfers data around at 12mbps, with each new device added to your system taking up
progressively more of the available transfer pipe until you hit a point where your USB gets overloaded.
USB 2.0 is a massive speed increase to 480mbps, which leaves plenty of room for most device
operations.

Finding out if you have USB 1.1 or 2.0 is complicated because some motherboards don't accurately
identify your device as USB 2.0. To find out which version you have, open the Device Manager by
right-clicking My Computer and choosing Properties (or with Windows key + Pause/Break on the
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keyboard). Click the Hardware tab and then click on the Device Manager. Scroll down until you locate
the Universal Serial Bus controllers and expand the list of controllers. If you have a USB 2.0 controller
in your computer, the word Enhanced will be listed somewhere in one of those names. In some case it
might say USB2 and some other case it might say Enhanced as well. The word Enhanced may appear
without any reference to USB2 or USB 2.0. If it says Enhanced, it doesn't matter what additional details
are included along with it. It's also important to make sure you know which USB ports on your computer
is connected to the USB 2.0 transfer bus. You may have a computer with USB ports on the front which
interface with USB 1.1 and transfer data slowly compared to the USB ports on the back of the computer,
which are USB 2.0.
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